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As part of the Evidence2Practice Ontario (E2P) program, 1

Amplify Care (formerly the eHealth Centre of Excellence) is

providing change management at no cost to support ampllfy cdare
clinicians with the implementation and optimal use of E2P

tools.

If you have any questions, please reach out to EMRtools@amplifycare.com and we will

be happy to help!
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A. Import the Custom Forms

1. In PS Suite EMR, from the % PSSuite® EMR (TEST) - X

. File Settings Reports Messages Window Help - @
Records WIndOW, Dr. Catherine Luangxay

choose Settings > Edit Logout | Appointments | Patients Inpatients Clients | Address chk| Handouts Messages
Custom Forms.

% Patient Record - Test, Twilight
File Edit Style Settings Patient View Data Letter 2

Choose Patient — Edit Stamps...

Edit Custom Forms...

Edit Searches...
Edit Cohorts...

Edit Reminders...

2. Inthe Forms window, % Forms X
H Fil
from the File menu,
New Custom Form... Ctrl+N §
Create Encounter Assistant
Choose Import Form(S). New Encounter Assistant... Ctrl+Shift+N A
Edit Form Ctrl+E Create Form
Rename Form Ctrl+R Edit Form
Duplicate Form Ctrl+D Duplicate

Deactivate Form

I Import Form(s)... I

Export Form(s)...
Show Revision History...
Show Deactivated Forms...

Restore from Automatic Save

3. Navigate to your computer’s desktop and double-click the folder that contains the
custom form files.

4. Click the custom form(s) in the list that you want to import.

5. Click the Choose button. If you are importing multiple forms at once, and depending on
the speed of your computer, the import may take 30 seconds or more.
A message will prompt you when the import is successful.

.|
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Optional Toolbar Customization

By default, the tools open as ‘pop-up’ windows. Selecting and saving this checkbox will

default the launching of tools directly into the progress notes section.

1. Navigate to %
Settings and Fil

select Edit Only show forms containing: e2p toolbar

Custom Forms

EEP - Toolbar

2.In the search
bar, type in “E2P".

Search for the
form titled:

“E2P - Toolbar”
Click “Edit Form".

In the pop-up
window, choose
Basic Editor.

Create Encounter Assistant
l Create Form
| Edit Form |
Duplicate
X |

With permission from TELUS Health, you can view and edit this form

using the basic editor. The basic editor allows you to change default

selections and add keywords.

Enter License Key for Full Editing {

Select the box

Yes - Use the Basic Editor

“Enable toolbar 2P [ Heart Failure | “meny s | Diabetes

E2P version bundle 4.2
Toolbar settings

ste_of_latest

buttons to insert

[ _Enable toolbar buttons ta insert tools directly into patient chart”

% ST Wil BpPIY 0 B Users

tools directly into
patient chart”

Click “Checked"” in
the box on the
right.
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B. Import Flowsheet

6. In PS Suite EMR, from the
Records window, choose

File Edit Style Settings Patient View Data Letter ) [

. ¥ Test, Twilight
View > Show Flowsheet.
V¥ Show Demographics Ctrl+D
Hide Resolved Problems
Show Last Renewal and Update Dates
< Hide Profile Ctrl+W
Hide Reminders Toolbar Ctrl+Alt+W
= Show Table of Contents Ctrl+Shift+T
| >~ Hide Attached Messages Alt+Shift+M
4 Show Lab Table Ctrl+T
= Show Flowsheet F1 E
7. Click File > click Utilities > EF'I-" Floshestfor Tlant fet |
| File View
then Choose Import Add Flowsheet for this Patient
Flowsheet Template. Add Global Flowsheet Ctrten FoTorMyRTESt -
] Rename This Flowsheet | I
i Delete Flowsheet -
4
Print... Ctrl+P {
| Utilities 24 Import Flowsheet Template...
| Export Flowsheet Template...
| Export as Tab Delimited...
[ Export as HTML...
i
i Remove Field(s) Add Field... Fill From Another Flowsheet...

8. Navigate to your computer’s desktop and double-click the folder that contains the
flowsheet files.

9. Click the flowsheet(s) in the list that you want to import. The flowsheets will be
“.flowsheet" files.

10. Click the Choose button. The import may take 30 seconds or more. A message will
prompt you when the import is successful.

www.E2P.ca e EMRtools@amplifycare.com 4
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C. Set Up Reminders

1.

In PS Suite EMR,
from the
Records
window,
choose
Settings > Edit
Reminders.

12. Click New

Reminder at
the bottom.

13. Enter “E2P

Toolbar” as
the name for
the reminder.
Then click Add
Line.

File Edit Style Settings Patient View Data Letter

WV TEST, Paula

Edit Stamps...

Edit Custom Forms...
Edit Searches...

Edit Cohorts...

Edit Reminders...

Edit Reminders of Paula TEST
No known

New Alert for Paula TEST...

Patient prg Q Increase Text Size

Flu Shot Q Decrease Text Size
Needs BP Grreor

E2P Tool Installation Guide
TELUS PS Suite EMR

) Z

New Quick Individual Reminder for Paula TEST...

Ctrl+1

Ctrl+!

= Edit Reminders
Edit

Remnders

2270 GreenSrook OR.TS -
1A8-COVID-19 Toobar

AFHTO Opicid Only PSS Front..,
AFHTO Opigids

alan depression temp reminder
Man - Greanbrook Nursng Test
alan test angela holdbrock

alan test smoking reminder
Alan toolbar 1.0

Andrew Street FHO Toolbar T.
amprioe toobar

ASA Candufates

atypical antipsychotic bw remi...
av

AV disbetes test

beimont test

bipolar trading
Bisphosphonate test

CDM - Reminder

CEP Falls Toobar

CEP Fall Toolbar Reminder
Chronic Non Cancer Pain CHC...

Cond_BMD-Osteopoross Oste. .

v

T —

TSI

% Edit Reminders
Edit

En Reminder Name 2P Toobar

Reminders

1AB-COVID-19 Toolbar

AFHTO Opioid Only PSS Front...
AFHTO Opioids

alan depression temp reminder
Alan - Greenbrook Nursing Test
alan test angela holdbrook

alan test smoking reminder

Alan toobar 1.0

Andrew Street FHO Toolbar T...
arnprior toolbar

ASA Candidates

atypical antipsychotic bw remi...
AV

AV diabetes test

beimont test

bipolar tracking

Bisphosphonate test

CDM - Reminder

Chronic Non Cancer Pain CNC...
CND OHT IFMT - Frailty Remin...
Cond_BMD-Osteoporosis Oste...

Delete Line

Indent Line ->

EditLine...

‘

<-Outdent Line

www.E2P.ca e EMRtools@amplifycare.com
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14. Click Other >

Current User
Initials >
contains >
enter PSS
initials.

15. Click Show

Custom Form
or Stamps and
select

“E2P -
Toolbar”. Then
click Done to
save your
work.

E2P Tool Installation Guide
TELUS PS Suite EMR

% Add Search Criterion

Demographics

Patient Profile

Vigits

Vitals

Immunizations
[Treatment

Allergies

CPP Problems

CPP Past Medical History
CPP Family History

CPP Risk Factors

Lab Values

Lab Text

Diagnostic Imaging
Diagnostic Test Reports
Consultation Report
Miscelaneous Letters
Medical Report

Custom Forms

Cohorts

Pending Tests/Consults
gills

Appointments

All Text Notes

|

Restrictions

Mested Reminder
Scoring

= Edit Reminders
Edit

Enter search text>

Current Doctor Initials
Current Liser's Role
I

|
Today's Date
5
is not
is empty

is not empty
starts with

ends with

Reminder Name: E2P Toolbar

Reminders

1AB-COVID-19 Toolbar

AFHTO Opioid Only PSS Front...
AFHTO Opioids

alan depression temp reminder
Alan - Greenbrook Nursing Test
alan test angela holdbrook

alan test smoking reminder

Alan toolbar 1.0

Andrew Street FHO Toolbar T...
arnprior toolbar

ASA Candidates

AV

AV diabetes test

belmont test

bipolar tracking
Bisphosphonate test

CDM - Reminder

Chronic Non Cancer Pain CNC...

Cond_BW-Bariatric Surgery M...

atypical antipsychotic bw remi...

CND OHT IFMT - Frailty Remin...
Cond_BMD-Osteoporosis Oste...

contains the word Py
|does not contain the word
does not contain

Lurrent User Initials contains CL

Delete Line

Indent Line ->

v |Comments:

() Show Intervention as Reminder:

(@) Show Custom Form or Stamp:
Priority:

Delete Reminder

(O High (scan daily)

Edit Line...

| E2P - Toolbar

VI

(® Medium (reminder report)

O Low (next visit)

Cancel Add

www.E2P.ca e EMRtools@amplifycare.com
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D. New Tool Version Process

After you have downloaded the updated tool package, follow these steps to import the tool

into the EMR.

Heart Failure Management Tool - Version 3.0 Update
Before using the updated Heart Failure Management Tool, you must complete the form
customizations and localization settings for certain features to work.

'| NaVigOte tO File Edit Style Settings Patient View Data Letter =) [
. V' TEST, Paula Edit Stamps...
settlngs Gnd Edit Custom Forms... -
Se'ect Edit Edit Searches...
Edit Cohorts...
Custom Forms pr—
Edit Reminders...
Edit Reminders of Paula TEST
Mew Quick Individual Reminder for Paula TEST...
New Alert for Paula TEST... -
Patient prq @ Increase Text Size Ctrl+ 1
Flu Shot Q Decrease Text Size Ctrl+4

Needs BP rrcor

2.In the search -
.
bar, type in “E2P Fie

H F,, Only show forms containing lizp HF I Create Encounter Assistant

[E2P - HF - Main Form T 0.0
E2P - HF - Main Form Toolkit PSS v1. 1 Create Form
E2P - HF - Management Plan PSS

EZP - HF - Management Plan PSS v1.0.0

Seq rCh for the E2P - HF - Management Plan PSS v1.1

E2P - HF - Medication Module PSS
. . E2P - HF - Medication Module PSS Duplicate
form titled: 2P - HF - Medication Module PSS v1.0.0

E2P - HF - Medication Module PSS v1.1

“E2P — HF - Visit E2P - HF - Patient Care Plan and Resources PSS

E2P - HF - Patient Care Plan and Resources PSS v1.0.0
E2P - HF - Patient Care Plan and Resources PSS v1.1

Form PSS"” 29 - HF - Review Patient

. . E2P - HF -Risk Factors
Click “Edit Form". e

E2P - HF - Visit Form PSS 2nd corrupted
E2P - HF - Visit Form PSS Branch Diego QA
E2P - HF - Visit Form PSS Branch Tirth

In the pop-up 1 Rl e
window, choose ———

Basic Editor.

3. Drag the button
scroll bar to the
center to reveal
the “form settings
— customization
and localization
setting” window.

oom: | 125%

e ST )

§y_Text_VtaIl YHA" text_of lates!
- pecify_Text_Vital"@Hidiagnosis™ text_of_latest

Form settings - customization and localization settings

1. Select option

Ems08" Iatest_text_value ”k e
@30 & wr
BmS63" Iatest_text_value & = v
7 Fax Cover Page
® Patent Property...
Patient Search

P
Seo

Fwan google.ca
2013 Lab Requisition

2R

east_ Cancer_Screening Refused

32

etter

i

|_and_RBG

8

| Y MNeWBEOR / 000m0 >~

Please ensure to
pull the bottom
right up to reveal
the editor settings.

oriPainRefLetterTenclate
c

ONCP_ction_Plan

® ONCP_Adverse_Chidhood

® ONCP_Demographic_and_Socal
. P Fs

® ONCP_funcsoc_hx

® CNCP_Medical Consuits

', eyt

g9

W website W custom form lavel

ssesssssnsslesne

W website W custom form lavel

W vebsite [l custom form iabel
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To customize the SOAP note stamp to a different stamp follow these instructions.
If you would like to use the default stamp developed by E2P, please skip this step.

1. Click on the
custom stamp
box.

In the window on
the right, scroll
down to the line
for “Checked".

Then click on the
box next to it to
check it off.

Form settings - and localizati tting |
Changes MU ST be made and saved in form editor mode. Customizations. will be reflected site-wide for all users

Enable only ONE checkbox 1. Select option 2. Stamp name

Reaource mst b completed i customiziog

Default 2P stamp will be selected othenwise None (Al Scribe)

s
X
X

rronouns
Current User
Current Doctor
Patient Doctor
Referring Doctor
Famiy Doctor
Profie
Address Book Entry
Fax Cover Page

@ Patient Property...

@ Patient Search...

& Dabiant Damindar

Fed - o00m

Name

Show Edt Text Border
Inchude In Printout

| Compact Stamp Text

[ Ul.‘- g

Graph As
Graph Date Feld 1d
Rescures Narma

Tab Order lo

[Keyword for Selection
Event Triggered undolserEd#sinLaunchMode
| Custom Height s

2. Stamp name

e Click onthe
corresponding
blank box.

On the top right
half of the
window:

e Scroll down to
the Stamps
list and search
for the stamp
you would like
to embed.

Then on the
bottom right half
of the window:

e Scroll down to
the line for
“Text".

e Then enter the
name of the
stamp you
wish to add.

_pecify_Text_Vital @Hidiagnosis .text_c

Form settings - customization and localization settings
Changes MUST be made and saved in form editor mode. Customizations will be reflected site-wide for all users

2, Stami name

Enable only ONE checkbox

1. Select option
M custom stamp
W None (Al Scribe)

Resource must be completed if customizing

Default E2P stamp will be selected otherwise

oy
B Stamps. 2
® assisstive_devices
- ® bp
= | @ Breast_cancer_Screening Refused
e oo
(i « chol
® Chol_snd_REG
B ¢ colres
e = = @ ChronicPainRefLetter Template
LI e anc
[ ® CONCP_Action_Plan
® CNCP_Adverse_Chidhood
® ONCP_Demographic_and_Socal
® CNCP_FS
® ONCP_funcsoc_hx
® CNCP_Medical_Consuits
® ONCP MH hx
Hame value
Colour JBtack
Visble 10
Opaque 0
Event Handiers
Toote Text
skl atog
Test chi |
Fort Name ehetcs
£ s
|Style plan
wickh &
IRequired T ml

www.E2P.ca e EMRtools@amplifycare.com
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If you are using Al Scribe, you may wish to disable the stamp functionality.
e - —— e
C|ICk on the bOX Form settings - customization and localization settings | E E::::gu
for Changes MU ST be made and saved in form editor mode Customizations wall be reflected site-wade for all users — Patient Doctor
; Referring Doctor
. Enable only ONE checkbox 1. Select option 2. Stamp name — EM;ZM
None (Al Scribe) S . p—— 10| i A ke
Default E 2P stamp will be selected otherwise o Fax Cover Page
@ ® Patient Property
i - tmme
In the window on Referrai targets
1. Select Type 2. Input display label 3. Add Resource Name (website or custom form) e e
H M vebste W custom form test waww ehealthce ca v
the rlght’ scroll M vebste W custom orm google rwwwgoogle.ca ?::::‘::;::?" =
dOWh to the Iine :Mnm :wmm om — 2013 Lab Reuietion Compact Stamp Text 10
website custom form label resource name |Graph As
for "CheCked". W vebste W custom orm label resource name ‘:::::::;:‘“ id
imaging referral targets. Tab Order o
B Bomren o i = K |
Then CI|Ck on the M vebsite W custom form Iabel resource name 1 :\:("Y“::;:’““ — T
box next to it to e ’
check it off.
To customize the form resources, follow these instructions.
To set a website referral or Imaging referral targets, follow these steps:
. Form settings - customization and localization settings | = - Pronouns
]' SeIeCt Type' Changes MUST be made and saved in form editor mode. Customizations will be reflected site-wide for all users | | -
Click on the box — =
for website 1. Select option 2. Stamp name
e Inthe window
on the right, Referral targets , :
g 1.!'Sehcl Type 2. Input display label 3. Add Resource Name (website or custom form) U
scroll down to 8
. website [l custom form label resource name .
the Ilne fOl' M website [l custom form label resource name
" " B website custom form abel resource name
CheCKed . n we:s:e : :us:um:nrm :a:e: resource name
e Thenclickon | g e LK ]
. website custom form labe! resource name
the box neXt to | | we:s:e : cu:um :rm :a::: resource name
it to check it - -
off.
H Form settings - ct ization and localization settings = - Pronouns
2. InpUt dlsplqy Changes MUST be made and saved in form editor mode. Customizations will be reflected site-wide for all users ‘ ||
Name Vaive
label
e Clickonthe e
label box. . S
In the window on Referral targets
. 1. Select Type 2. Input display label 3. Add Resource Name (website or custom form)
the r|ght, SCFO|| M website M custom form resource name - —
. M website [l custom form label resource name = ros e 40 ]
dOWh tO the Ilne M website [l custom form label resource name
P ” M website [l custom form label resource name
fOI’ Text . B website [l custom form label resource name k 1
e Thenentera imging referal targets "
M vebsite [l custom form label resource name
nﬂme fOI’ the M website Wl custom form label resource name
B vebsite [l custom form label resource name
referral you
wish to add.

www.E2P.ca e EMRtools@amplifycare.com 9
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down to the line

for “Text".

e Thenentera
name for the
referral you
wish to add.

3. Add Resource Form settings - and | settings ‘ | z v ;'a;:::u
. Changes MUST be made and saved in form editor mode. Customizations will be reflected site-wide for all users I — —
Name (website or
custom form) P B
e Click onthe
resource Referral targets
1. Select Type 2. Input display label 3. Add Resource Name (website or custom form)
nCIme bOX M website Wl custom form Diuretic Regimen |resaul:e name |
. M website Wl custom form label resource name W
In the WIndOW on W website [l Lus:nmlovm label resource name .
. W website [l custom form label resource name
the ”9ht: SCfO" B website [l custom form label resource name
dOWI’\ tO the Iine imaging referral targets
" " M vebsite [l custom form label resource name
for TeXt . B website W cusiom form label resource name
B vebsite custom form s resource name
e Then enter the o Memmem
link for the
referral you
wish to add.
To set a custom form referral target follow these steps:
]. SeleCt Type: Form settings - i anq' ?enings . ‘ : F"::;'s
Changes MUST be made and saved in form editor mode. Customizations will be reflected site-wide for all users
Click on the box e =
for custom form. 1. Select option 2. Stamp name
e Inthe window S
On the I’Ig ht, Referral targets
1. Select Type 2. Input display label 3. Add Resource Name (website or custom form)
SCFO|| dOWﬂ tO B website M custom form Diuretic Regimen https //decongest ca/
. W website I mm label resource name
the line for 0 websuem Iabel resource name
" " W website M custom form label resource name
CheCI(ed . M website [l custom form label resource name
e Then clickon imaging roferraltorgots | EE e |
I website Ml custom form label resource name
the box next to M website I custom form label resource name
. . B website [l custom form label resource name
it to check it L
off.
2. Input dlSple Form settings - |n§' settings ‘ | ‘Z Pronouns
Changes MUST be made and saved in form editor mode. Customizations will be reflected site-wide for all users
label o o
e Click onthe P -
label box.
In the WindOW On Referral targets
. 1. Select Type 2. Input display label 3. Add Resource Name (webs ite or custom form)
the r|ght, SCFO|| . website [l custom form Diuretic Regimen https://decongest ca/
B website M custom form resource name ft uckeo |

B website [ custom form label resource name
M website [l custom form label resource name
B website [l custom form label resource name
imaging referral targets

M website M custom form label resource name
W website [l custom form label resource name
M viebsie [l custom form label

resource name

www.E2P.ca e EMRtools@amplifycare.com
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3. Find the form
name:

Go to the forms
search bar, select
the custom form,
right-click, and
choose "Rename
Form.

Copy (Ctrl +C) the
form name. Then
click cancel to
close the window.

Navigate back to
the HF Tool form
settings window.

File

Only show forms containing | weight log |  create Encounter Assistant
[CHF Sept 2017 for demo only

Heart Failure Visit Tool QBIC - new layout Create Form

Heart Faiure Visit Tool QBIC - originallayout 1

HF layout example 1 Edit Form
Paliative Form Edit Form Duplicate

e [ ]

QBIC Congestive

laBic Congestive H Duplicate Form
QBIC Congestive H Deactivate Form
QBIC Congestive Heart Failure CHF (N_Hastings)
QBIC Heart Failure HF - Dr Spanglet
SC_HF_Layoutvital

& Progres
o Re 0 What is the new name for "HF Weight Log'?

0K 1 Cancel

SN Y

3. Add Resource
Name

Click on the
resource name
box.

In the window on
the right, scroll
down to the line
for “Text”.

Paste (CTRL +V)
the name of the
referral you wish
to add.

Form settings - customization and ization settings ‘ Name Vake
Changes MU ST be made and saved in form editor mode. Customizations will be reflected site-wide for all users =

2. Stamp name

m _resource on =
Referral targets
1. Select Type 2.Input display label 3. Add Resource Name (website or custom form) =3 U Weght g

' website [l custom form test www ehealthce ca 2

M website M custom form google rwww.google.ca

M website B custom form Weight log HF Weightiog —— —— —— ~ "~ "7

W website [l custom form label HF Weight log

W website [l custom form label resource name

imaging referral targets

M website W custom form label resource name
W website Wl custom form label resource name
W website [l custom form label resource name

Navigate to the
top left corner to
save your work!

Or use your
keyboard CTRL +S
to Save.

§ H Edit E2P - HF - Visit Form PSS

File Edit Custom Form
Save Ctrl+S  Text Vital'NYHA"text of latest
Test Print Ctrl+P

Utilities > m settings - customization and locali:

1ges MU ST be made and saved in form editor mode.
Close Ctrl+W

www.E2P.ca e EMRtools@amplifycare.com 1
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A. Tool Feedback

We would love to hear your feedback! Users are welcome to share their thoughts and opinions
regarding the tool. We've also included the ability to share your feedback anonymously or you
can also include your email address if you would like to be contacted in the future.

*Links can be found at the footer of the screening & visit tools next to the usage analytics link

B. Overview of Usage Analytics

Please visit our website to review our overview of usage analytics.

C. Known Issues/Errors

1. Rendering custom form issues:

|Problem: All sites will experience the form overlapping issue on the first opening of the tools after
installation/update.

Solution: Unfortunately, this is a known PS Suite error. Open each E2P form and if this issue is seen,

close the window and re-open. Please note that this will only happen once, you will not encounter this
for each patient.

Ligstiye and seif managemen(d
DCiabatis METSGEmEnt Should b &%) MGt A0 SolIsr e
e individu: 'I!melﬁ anom-w:nu wilabile 1o them

Ergetily d:dqupu‘n_!‘-;u —

[@RE- LT I"

= Rescurces and care plan
_.;Wuwm ba-paran-caighd. eeling o, .,
. mmol

«nqanfp:ra\{»::lmm nmu:.:‘l;i"\l
00 No.

ul#i:lmn-ul\umr 038 -!.ug. TaemmoliL

S#m:rau il F v

L
ducated on driviag salely (uBng itpelia orinmlin MEIgoguel
-

T 1 S BB E AIECENEN CATIRDRErAm

2. Tool Installation Troubleshooting:

|Problem: Some users have experienced an error message during installation resulting in a cancelled
installation with no forms being imported. This is most often seen when importing the “E2P — MH —
Anxiety Disorders and Depression Visit Tool”. We believe this may occur due to the EMRs temporary
files folder being full, the file size of the forms, and the long file path of forms.

Troubleshooting:
1. Tryimporting forms in smaller batches (5 or less has been found to be helpful)

2. Do not import the largest files together or import the largest files individually (i.e. separate the
installation of the Inlow’s and 'E2P — MH — Anxiety Disorders and Depression Visit Tool').

3. Logging out and back in of the EMR can sometimes help clear the temp folder and fix
installation

www.E2P.ca e EMRtools@amplifycare.com 12
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4. Try placing the folder temporarily on your desktop before installing to reduce the file path.

If you are still unable to import the form and would like support, contact us at
EMRtools@amplifycare.com.
Please take a screenshot of the error message so that was can best assist you.

X

0' An error occurred while importing custom forms and the process has
been aborted:
c:\pss\10.235.56.5\com.pss. TempFileManager\client\psstemp-df6876d7
428441fe913bbalef2686e74\form.xml.

3. Javascript “An unexpected error occurred in PS Suite® EMR” window

Problem: Some environments will not accommodate the Usage Analytics script. In these cases,
an ‘unexpected error’ window will pop up when trying to launch the custom forms.

Troubleshooting: Users will be required to disable usage analytics.

i. Inthe patient record in Settings > Edit Custom Forms ..., find and select each of
the E2P forms that contain Usage Analytics*. Click button ‘Edit Form’
ii. Locate the box containing the usage analytics script
e W Spirometry declined Proceed with an unconfirmed diagnosis? B vyes

{ T"salesforceEmrToolld":
Amplify Care terme and conditions

"a030H000007RrIkYAK",
mplify "salesforceEmrToolBaseName™: "E2P - COPD -
- Screening and Diagnosis Form PSS”,
9y "salesforceEmrToolVersion™: "1.2%,
"emrUserHash": null, “emrRecordHash": null,

"latestConsentChangeDate": null,
"formInstanceld”: null }

iii. Select the checkbox item ‘Disable analytics’
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Accessible. Actionable. Adaptable.

iv. Inthe properties panel —ensure ‘Checked’ is selected

yme”: "E2P - COPD - Include In Printout
‘orm PSS", Compact Stamp Text
V1,25, Graph As
smrRecordHash": null, Graph Date Field Id
2": null,

Resource Name
Tab Order
Radio Button
Checked
Diameter 10
Keyword for Selection
Event Triggerad

[=]

v. Go to File > Save
vi. Import forms again

*forms using Usage Analytics include:
= E2P - COPD - Screening and Diagnosis PSS
=  E2P - COPD Management Visit Form PSS
= E2P - DM - Screening and Diagnosis PSS
= E2P-DM - Visit Form PSS
= E2P - HF - Visit Form PSS
= E2P - MH - Anxiety Disorders and Depression Tool Screening PSS
= E2P - MH - Anxiety Disorders and Depression Visit Tool PSS
= E2P - Patient Care Plan and Resources PSS

E2P brings together multi-disciplinary, cross-sector expertise under the joint leadership of the Centre for
Effective Practice, Amplify Care, and North York General Hospital. Funding and strategic guidance for E2P

is provided by Ontario Health in support of Ontario’s Digital First for Health Strategy.
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